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Readme File for IBM TRIRIGA 11.0.1 Fix Pack

This fix pack updates the IBM® TRIRIGA® product.
These release notes include the following:
e An overview of changes

e Many of the descriptions include an internal reference number (Tri-nnnnnn, IJnnnnn, IVnnnnn,
and/or RFE-nnnnnn)

IBM Docs for IBM TRIRIGA Application Platform 3.8. For more information, see the IBM TRIRIGA

@ Note - The IBM TRIRIGA wiki information, formerly located on DeveloperWorks, is migrated to
Release Information page on IBM Support.
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https://www.ibm.com/docs/en/tap/3.8
https://www.ibm.com/support/pages/node/1284928
https://www.ibm.com/support/pages/node/1284928

What’s New in This Release

IBM TRIRIGA 11.0.1 continues to add valuable functionality, fix defects, and reduce the effort necessary for
new and existing customers to implement our products.

Prerequisites and Supported Products
To install this fix pack, you must have IBM TRIRIGA 11.0 installed.

Installing the IBM TRIRIGA 11.0.1 Object Migration
Package

You must install the IBM TRIRIGA 11.0.1 object migration package on an existing TRIRIGA 11.0 installation.
You must have IBM TRIRIGA Application Platform 4.0.1 or later installed.

those objects. Review the list of objects by using the Object Migration tool before you

2 Caution - The fix pack will overwrite existing objects and any customizations made to
import the package.

Procedure
Follow these steps to apply the fix pack:

1. Extract the OM package ZIP file.

2. In the Administrator Console, ensure the Object Migration Agent and the Object Publish Agent are
running.

Log in to TRIRIGA as an administrator.

Go to Tools > Object Migration.

Click New Import Package.

Browse for the OM package ZIP file extracted in Step 1 and click OK.

Use the Validate action to verify that the objects can be imported successfully.

Use the Import action to initiate the import process. A notification is sent to the user when

the import process is complete.

PN AW

What to do next

After the import process is complete, log in to TRIRIGA and check the application version by clicking the
information icon in the upper-right corner of the TRIRIGA window.
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IBM TRIRIGA 11.0.1 Patch Helper Workflows

Patch helper workflows correct the record data in your IBM TRIRIGA Application. A patch helper workflow
can revise and update, bring new data records for a release, and recalculate records. The patch helper
makes necessary changes to your IBM TRIRIGA database. You apply the patch helper workflows for a release
after you install or upgrade to that release. Wait for one patch helper workflow to complete before you
begin the next. Some patch helper workflows can take a long time to complete.

Note: Many of the patch helpers included in this release have already been included in earlier fix packs, as
shown in the patch helper name. When you run the main 11.0.1 patch helper workflow, it determines which
of the other patch helper workflows have already been applied and does not re-run any that are already
applied to your system.

The following patch helper workflows are in this release:

Name Description

triPatchHelper - Synchronous - 11.0.1 - The 11.0.1 patch helper workflows will be triggered

Main Patch Helper automatically after the 11.0.1 OM package is finished
importing.

triPatchHelper - triCalculate - 11.0.1 - This patch helper updates the application version record with

Application Data - App Version the upgraded date if an application version exists, otherwise,

it creates an application version record.

triPatchHelper - triCalculate - 11.0.1 - The patch helper workflow is used to map field

Application Settings Defaults "triRetryAttemptsNU" under Reservation Settings tab of
Application Settings record.

triPatchHelper - triCalculate - 11.0.1 - This patch helper workflow hides attention message for

Hide Attention Message from Facilities completed facility projects.

Projects

triPatchHelper - triCalculate - 11.0.1 - This patch helper workflow removes additional contract

Remove Additional Contract Attribute attribute records associated with leases.

triPatchHelper - triCalculate - 11.0.1 - This patch helper retires building system item records

Retire Building System Items associated to retired buildings.

triPatchHelper - triCalculate - 11.0.1 - This patch helper updates task primary location where

Update Primary Location of Work Task location path is invalid.

triPatchHelper - triCalculate - 11.0.1 - This patch helper updates asset's primary location where the

Update Primary Location of Asset location path is invalid.
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IBM TRIRIGA 11.0.1 Enhancements

The following enhancements are included in the IBM TRIRIGA 11.0.1 fix pack.

Facilities Projects A new field, 'Responsible Role’, has been added to the Task record under the
General tab > Responsible Person section. This field can be selected manually
while creating the record.

In the Capital/Facilities Project record > Schedule tab > Project Tasks section, if
you click the ‘Assign Task by Role’ section action, the system will pick the
Responsible Role from the General tab of the selected Task record and find the
corresponding responsible person from the matching contact role of the
Capital/Facilities project. The details of the responsible person retrieved will be
mapped to the General tab of the Task record > Responsible Person section.

For example, for the Building Condition Manager Contact role of a Facilities
Project, Person A is assigned as a Contact.

Now, a Work Task record is created from the Facilities Project > Schedule tab >
Project Tasks section. On this Work Task record, on the General tab, in the
Responsible Person section, the Building Condition Manager Contact role is
selected as a Responsible Role.

Next, if the ‘Assign Task by Role’ section action in the Facilities Project record >
Schedule tab > Project Tasks section is clicked; then, Person A will be mapped to
the General tab of Task Record > Responsible Person section.

(Tri-90413-1J26402)

Lease - Asset and Real | The Total Rent Expenses fields in the Schedule Summary section (on the
Estate Accounting tab) and the Amortization Summary section (on the Local Reporting
tab) now include the Dismantle Cost for an IFRS lease. (Tri-90334)

Lease - Asset and Real | The Gain/Loss column in Accounting Schedules follows the same sign convention

Estate in all the scenarios. If it’s a loss, it displays a positive (+) amount in the Gain/Loss
column. If it’s a gain, it displays a negative (-) amount in the Gain/Loss column.
(Tri-90327-1J32130)

Lease - Asset and Real | On the Calculation Inputs tab, a new column 'Nth Period From Cumulative From
Estate Period' is added to the Lease Journal Entry Setup form. This helps in selecting the
Nth Period from the Cumulative From period in the calculations. (Tri-90321)

Lease - Asset and Real | A new Period 'Original Accounting Start Period' is added to the Calculation Period
Estate list of Journal Entry Calculation Input. (Tri-90375)

© Copyright IBM Corporation 2023. 5



IBM TRIRIGA 11.0.1 Changes

The following changes are included in the IBM TRIRIGA 11.0.1 fix pack.

Area of Change Description

Approvals The approval process for the "Process Payments” BO has been updated. The
system will now consider the sum of "Expected Amount with tax" from the
associated Payment line items as the Approval amount.

The following updates were made:

1. Updated the workflow: triProcessPayments - trilssue - Submit for
Approval and Dependent Record Update.

2. Added Retrieve task to get sum of 'Expected Amount with tax' of
associated PLIs.

3. Mapped triApprovalamountNU.

(Tri-90309-1J26741)

Facilities Projects In a Program record, for each Funding Request created for the Facilities
Project type, the "Total Funding” column is computed and displayed in the
Projects section in the Program record. The Total Fund field is also displayed
in the Facility Project record > Facilities Project Request > General > Summary
section. (Tri-90420-1J37826)

Facility Projects In a Program record, for each Funding Request that is created for the Facility
Project type, the "Total Funding” column is computed and displayed under the
Project section. The total fund is also displayed in the Facility Project record >
General tab > Summary section.

In Facility Project, a new "Funding Allocations” section is added in the Budget
tab. This section displays the funds that are allocated to the Facility Project.
You can perform the following actions in the Funding Allocation section:

1. Add Funding Allocations: use this action to add funds to the Facility
Project.

2. Transfer Funds: use this action to transfer funds from the Facility
Project.

(Tri-90423)

Geography If the name on the Geography record changes, on the Save action, the system
will update the new name on all descendent geographies. Also, on the
Geography record, the Reporting section will update the parent fields as per
the new name. The new name will also be updated on all the buildings that are
associated with the updated geography. (Tri-90425-1341726)

Geography If you cut a Geography record and paste it under another Geography record,
the correct parent data will be mapped to the Geography record.

(Tri-90426-1J44371)
Job Plans When users navigate to the Maintenance Landing page, they will be able to
view the Job Plans created by them and associated with their organization in

the 'My Draft Job Plans' and '‘My Active Job Plans’ portal sections.
(Tri-90373-1J34971)
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Area of Change

Description

Key Management

Lease - Asset and Real
Estate

Lease - Asset and Real
Estate

Lease - Asset and Real
Estate

Lease - Asset and Real
Estate

Lease - Asset and Real
Estate

When you create a Key Request under Facilities request, on Copy action of the
Key Request, a Key Request record is created instead of a Service Request
record. (Tri-90415-1J43455)

While performing 'Non-Lease-Accounting Amendment’, the user actions will be
limited.

e Cannot generate/remove/update payment schedules with the
Summary Type 'Rent’ and ‘Include In Amortization’ or ‘Include In Rental
Prepayment’ set to TRUE, or with the Summary Type 'Incentive’ and
‘Include In Upfront Incentive' set to TRUE.

e (Can update payment instructions for any payment schedule.

e (Can update the following sections on Options: Document Reference,
Comments, Notify Roles, Notify Within.

e (Can exercise reasonably certain options (i.e. already set as likely term
option).

e Cannot set an option as Likely Term and exercise any option which is
not reasonably certain (i.e. likely term).

e (Can Add/Remove/Update any non-index clause.

e Can update any sections on Index Clause, except Index Adjustments,
Payment Schedule, Options.

e Cannot add/remove/update the Premise Locations section on the
Locations tab for RE Lease and Leased Assets section on the Assets tab
for Asset Lease.

(Tri-90386-1J30783)

The answers to the ownership questions on the Local Reporting tab are now
updated based on the answers sets for the same questions on the Accounting
tab. (ASC 842 or IFRS 16). (Tri-90383)

The Ownership and Purchase Option questions on the Local Reporting tab are
no longer linked to questions under IFRS/FASB Treatment section. (Tri-90382)

Fields for ‘Short Term Lease’ and ‘Include In Amortization’ are added to the
Local Reporting tab. This is to differentiate GAAP and IFRS in the case GAAP is
still short term, but IFRS is not.

A new straight-line schedule is visible if the lease is a short-term lease and
Include In Amortization is not selected. The schedule is also available on the
Local Reporting tab.

Reassessment of Short Term lease after Modification:

GAAP (FASB): For a Short Term lease, when there is a change in lease terms
either by an Option or by changing the Accounting End Date, if the remaining
lease term extends for more than 12 months from the end of the previously-
determined lease term, the lease will not qualify as Short Term Lease.

IFRS (IASB): For a Short Term lease, on reassessment, if the likely term is more
than 12 months, the lease will not qualify as Short Term Lease.

When there is a modification and the lease is no longer a short-term lease, the
transition/adjustments of IDC, Prepayment, and Accrued Liability will be
included in the Operating/Finance schedule. (Tri-90381-1J25706)

On the Accounting and Local Reporting tabs, the GAAP Classification question,
“Is it reasonably certain at commencement date that the purchase option will
be exercised at the end of the lease?” is set to be read-only.
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Area of Change Description

On the Initial lease, the answer to this question is set to 'Yes' if there is a likely
purchase option.

For both GAAP and IFRS leases, the classification question, "Does property
transfer ownership at the end of the lease?" will be set to 'Yes' if there is a
likely purchase option.

IFRS Classification section is now labeled as 'Other Information'. (Tri-90380)

Lease - Asset and Real The Lease Classification question, 'Does Property Transfer Ownership at the
Estate end of the lease? is now visible for IFRS Leases. If it is set to 'Yes', the lease is
no longer short term. (Tri-90378)

Lease - Asset and Real Calculations of leases for less than a month are modified, and the Asset value
Estate is coming down to zero for both Operating and Finance schedules.
(TRI-90360-1J25249)

Lease - Asset and Real The Include In Amortization Schedule checkbox will be set to read-only after a
Estate short-term lease is modified. (Tri-90384)

Lease - Asset and Real A lease still qualifies as short term if likely term<=12 months and initially, it
Estate was short term=Yes. (Tri-90385)

Lease - Asset and Real When a user performs a non-lease accounting amendment type revision, the
Estate Payment Schedules of Rent and Tenant Improvement Incentive types cannot be
voided. (Tri-90433-1J37263)

Lease - Asset and Real On making non-lease-accounting amendments, the section actions in the

Estate Payment Schedules section of clauses are not hidden and allow to Find or
Generate Payment Schedules except for the following type of payment
schedules:

1. Payment Schedules with the Summary Type 'Rent’ and 'Include In
Amortization’ or 'Include In Rental Prepayment’ set to TRUE.

2. Payment Schedules with the Summary Type ‘Incentive’ and 'Include In
Upfront Incentive' set to TRUE.

(Tri-90371-1J35915)
Lease - Asset and Real The Accounting and Clauses, Options & Terms tabs are set to read-only after

Estate you go to Contract Revise > Non-Lease-Accounting Amendment, and then click
Cancel. (Tri-90387)

Lease - Asset and Real For Asset Leases, whenever a modification is done, the Modification History
Estate section on the History tab displays the records. (Tri-90350)

Lease - Asset and Real The History tab of a Real Estate and Asset Lease displays the Created Time of
Estate the Current and Previous Amendments. (Tri-90351-1J41672)

Lease - Asset and Real When users remove the scheduled status Payment Schedule, the associated
Estate payment Instruction will not get retired if that Payment Instruction has any

Pending status Payment Schedule associated to it. (Tri-90337-1J44216)

Lease - Asset and Real For a Payment Schedule record with Partial Payments, the Expected Date field

Estate in the Partial First and Partial Last Payment sections is editable and can be
updated by a user. The updated value entered by a user will be retained even
if the Payment Schedule record is closed and reopened. (Tri-90416-1J44341)
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Area of Change

Description

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

For an IFRS lease, in the Finance Schedule section, the '(Gain) Loss on
Revaluation' column is now populated with Gain when the IFRS Reversal
Impairment is performed. The gain is the IFRS Reversal Impairment Amount
Allowed. (Tri-90330)

The Net Equity for the IFRS reversal impairment period is now calculated
correctly (Net Asset - Liability). (Tri-90331)

On clearing the likely term option from the Lease > Accounting tab > Term
Option section, the Accounting End Date is updated and mapped from the
latest history lease without a likely term option associated with the lease.
(Tri-90340)

On an Operating lease, when you perform a modification after the lease is
impaired, the Accrued Liability now comes down to 0. (Tri-90328)

When a lease is amended after Accounting revise > Data Revise, all the
required sections are editable. (Tri-90349-1J34262)

If an approval request has been returned and then resubmitted, the “Only re-
reviewed by who returned and subsequent reviewers” action routes the
approval to the reviewer who returned it. However, If the reviewer who
returned the approval is no longer associated to the record for that role then
approval will route to the person who is currently assigned. Once approved by
that approver, the approval routing resumes with the next reviewer.
(Tri-90411-1J44946)

When abandonment is performed, RVG, IDC, and IBR fields are read-only and
the Calculate NPV action is hidden. (Tri-90348)

After adjusting the payment schedules, the partial payment line items and
catchup payment line items are generated correctly. (Tri-90347- 1J29039)

When a Business Unit contains an apostrophe () or a single quote (' ') in its
name, all disclosure BIRT reports generate correct result. (Tri-90428-1J41509)

When a lease is terminated in the middle of the month by using Prorated
Payment Option, then the Amounts on Payment Line Item and Fiscal Line Item
are calculated correctly. (Tri-90346-1J35042)

After modification, the Fiscal Line Items are calculated correctly for leases
that have a start date as 30th or 31st. (Tri-90429-1J35507)

Multiple contract attributes might be erroneously associated with a lease
record. The extra contract attribute records will be deleted from the leases
when the PatchHelper workflow, triPatchHelper - triCalculate - 10.X Gemini -
Remove Additional Contract Attribute, is run. Only one contract attribute must
be associated with the lease. The leases that have the status of Active,
Revision In Progress, Revision Accounting In Review, Review In Progress,
Routing In Progress, Terminated, Expired, and Retired will be included.

Note:

e This PatchHelper workflow might take a long time to run. If you
choose to filter for a set of leases, the query is “triContract -
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Area of Change

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Lease -
Estate

Asset and Real

Asset and Real

Asset and Real

Asset and Real

- Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Asset and Real

Description

Workflow - All Real Estate And Asset Leases Exclude History and
Upload Error”.

e Before triggering this PatchHelper workflow, you must inform the
users that they must not revise their leases or make any other changes
to their existing leases until the updates are completed.

(Tri-90324-1J30243)

The gain or loss calculated is now included in the Total Rent Expenses in the
Schedule Summary section.

Note: The Total Rent Expenses field in the Schedule Summary section of the
Accounting tab and the Amortization Schedule section of the Local Reporting
tab will now get calculated or updated after the accounting schedule gets
generated or recalculated. It will no longer get calculated or updated along
with the NPV. (Tri-90323)

When the Journal Entry period is set to the Accounting start or any date fields,
it does not cause performance issue and calculations are correct for the
period. (Tri-90364)

When a lease is terminated, the penalty amount is displayed under the Lease
Schedule Summary section. Journal Entry templates are set up pointing to the
penalty amount. (Tri-90359-1J26208)

During the modification of a lease, on the Contract Revision form, users will
not be able to select any fiscal period that is prior to the Accounting Start Date
or after the Accounting End Date. (Tri-90367-1J30333)

While modifying a Real Estate lease with a reduction in Square feet or Space,
the IFRS schedule on the Local tab or the Accounting tab includes a reduced
ROU Asset value based on the proportion of Square feet reduced.

While modifying an Asset lease with a reduction in the number of Assets, the
IFRS schedule on the Local tab or the Accounting tab includes a reduced ROU
Asset value based on the proportion of Assets reduced. (Tri-90320-1J29335)

Resolved the issue of Liability calculations for the 'Reclass Current to Long
Term Liability’ Journal Entry. (Tri-90376-1J26204)

When a lease is terminated at the end of the month or terminated partially,
Gain/Loss and Accumulated Gain/Loss is populated in Accounting Schedules.
(Tri-90345-1J40017)

While modifying a lease with a reduction in term, the IFRS schedule on the
Local tab or the Accounting tab includes a reduced ROU Asset value based on
the proportion of the number of periods reduced. It is applicable for both Asset
and Real Estate Lease. (Tri-90319-1J25051)

While using out-of-the-box JE Setup Templates, on Lease Expiration, the
accounts for Liability, ROU Asset, and Accumulated Amortization are closed
down to zero. (Tri-90318-1J25049)

An abandonment is now available. An accountant can perform an abandonment
on a lease by going to Accounting Revise > Contractual Factors. The
Abandonment checkbox will be available, and the Abandonment Date
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Area of Change Description

(Decommission Date) must be entered to accelerated amortized the asset to
the Abandonment Date.

The Decommission Date in the Schedule Summary section will be populated
with the Abandonment Date. Also, the Remaining Useful Life field will be
calculated from the Modification Effective Date to the Decommission Date.

The lease will be recalculated like a Finance lease and the asset will be
amortized straight lining up to the Decommission period. For an Operating
lease, the Rent Expense is no longer straight-line. The lease will continue to be
calculated like a Finance lease for any subsequence modifications.
(Tri-90338-1J31113)

Lease - Asset and Real A new ‘Alternative Period' field is added to the Lease Journal Entry Calculation
Estate Period form.

The Fiscal Period (of lease) from the Alternative Period is used in the Journal
Entry calculations if there is no Fiscal Period for the selected Calculation
Period or Cumulative From Period. (Tri-90317)

Lease - Asset and Real While issuing an index adjustment on a clause that has minimum percent, the
Estate Expected Amount on Payment Line Items is calculated correctly.
(Tri-90366-1J41203)

Lease - Asset and Real While recording AR Receipts, the precision of the value of the sum amount

Estate under the Expected Amount column and under the Delta Amount column is now
the same. AR Receipts Delta Amount computation is now up to a precision of
two decimal places. (Tri-90421-1J29395)

Lease - Asset and Real Activate action will be hidden from the Contract Administrator when the Lease
Estate Accountant returns the lease after submitting it for Revision Accounting In
Review. (Tri-90365-1J36880)

Lease - Asset and Real When the Rent Component Assumption section is updated for Contractual
Estate Factors, Journal Entries are generated. (Tri-90343-1J40690)

Lease - Asset and Real Resolved an issue where the Journal Entry period did not populate correctly
Estate when the accounting start date was set to a later date. (Tri-90404-1J41306)
Lease - Asset and Real The calculation for Interest Reduction on the accounting schedule is now
Estate computed correctly for a lease that has a lease incentive. (Tri-90363-1J25104)
Lease - Asset and Real While using out-of-the-box JE Setup Templates, on Lease Termination, the
Estate accounts for Liability, ROU Asset, and Accumulated Amortization are closed

down to zero. (Tri-90315-1J25046)

Lease - Asset and Real When a Lease is terminated before the current open period, reversal Journal
Estate Entry templates are created. (Tri-90358-1J35295)

Lease - Asset and Real When an asset is reduced to 0 and again extended, the asset value will come
Estate down to 0. The Gain/Loss from the previous modification gets deducted from

the net asset value; a Journal Entry gets created for this deducted amount.
(Tri-90314-1J25723)
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Area of Change Description
Lease - Asset and Real Segment Value Errors on Journal Entry Creation is now fixed for Department
Estate Accounting Cost Center and Division Accounting Cost Center.

(Tri-90310-1J25603)

Lease - Asset and Real The gain or loss amount generated on partial termination is added to the
Estate accrued Liability column. This fixes accounting schedules calculation issue on
multiple partial terminations. (Tri-90313-1J28880)

Lease - Asset and Real On Non-Lease Accounting Amendment, for Rent and Incentive Payments, the
Estate non-accounting fields can be updated while performing the payment
adjustment. (Tri-90374-1J32747)

Lease - Asset and Real Formulas for the following three columns are updated from the Operating or
Estate Finance schedule:

1. Liability Value is calculated by doing the sum of Current Period Change
in Liability and Previous Period Liability Value.

2. Long-Term Liability is calculated by Short Term Liability, Liability
Value, and Accrued Interest Balance.

3. Change in Liability is calculated from the Interest Expense, Interest
Reduction, and Principal Reduction.

(Tri-90342-1J44436)

Lease - Asset and Real For IFRS reduction in a term, when an option exists on the lease before a

Estate modification, the following scenarios are considered as reassessment and not a
modification. Therefore, the gain or loss calculated is no longer populated.
Also, the asset is adjusted based on the change in liability.

Scenario 1: A lease has a Termination option with Likely Termination Execute
before the Likely Term End Date. The option hasn’t yet been reasonably
certain before a modification. Later, the lease is modified to reasonably
certain on the Termination option.

Scenario 2: A lease has a Renewal option; the option is reasonably certain
before a modification. However, the lease is later modified to be not
reasonably certain on the renewal option. (Tri-90312)

Lease - Asset and Real On changing the Process Type, Process Journal Entries now retrieve leases
Estate correctly. (Tri-90344-1J39115)

Lease - Asset and Real The Contract Revise Screen now opens even when both the Base Lease
Estate Expiration Date and the Accounting End Date are blank.

(Tri-90311-1J26219)

Lease - Asset and Real On activation of a lease, now only one email notification will be sent to the
Estate user. (Tri-90369-1J35036)

Lease - Asset and Real Total Rent Expense includes Initial Direct Costs, Incentives, Exit or Disposal
Estate Liability Carryover, and Prepayments for both IFRS and GAAP leases.
(Tri-90333-1J32117)

Lease - Asset and Real Multiple issues of GAAP & IFRS leases for the Negative ROUA scenario are now
Estate fixed.
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Area of Change Description

e Scenario 1: Original lease + Full Impairment + perform modification to
reduce payments [For IFRS leases, Calculations for Gross Asset Value &
Accumulated Amortization are fixed]

e Scenario 2: Original lease + Perform modification to make lease
variable and reduce payments [For both GAAP & IFRS leases,
Calculations for Gross Asset Value & Accumulated Amortization are
fixed]

e Scenario 3: Original lease + Full Impairment + perform modification to
reduce space [For IFRS leases, Calculations for Gross Asset Value,
Accumulated Amortization & (Gain) Loss on Revaluation are fixed]

When the asset is already 0 and the adjustment to the asset at the
modification no longer reduces the gross asset further and if the adjustment to
the asset is more than the current asset itself, the gross asset will now be
adjusted to the current asset amount. Both gross assets and accumulated
amortization are now calculated correctly. (Tri-90316-1J31960)

Lease - Asset and Real The Lease Local Reporting utility is designed for the leases where local

Estate reporting is not enabled upon the initial lease activation, but, at a later point,
local reporting schedules are required. The utility will create a mirror lease, a
replica of the original lease. Based on the local reporting look back period set
on the application settings record, the system might perform local reporting
standard adoption on the mirror lease. Next, all the modifications performed
on the original lease of types Amendment, Change In Assessment, and
Contractual Factors will be applied to the mirror lease in the same sequence.
Finally, after all the modifications are updated to the mirror leases and lease
schedules recalculated, all the details from the lease local reporting tab of the
mirror lease will copy over to the original lease. For more details, refer to the
Lease Local Reporting Utility user guide in version 11.1. (Tri-90361-1J22846)

Lease - Asset and Real When a lease is terminated and the Due Date of the terminated Payment Line
Estate Item is after the Termination Effective Date, then the Due Date is updated
with the Termination Effective Date. (Tri-90341-1J34801)

Lease - Asset and Real Users will now be able to perform amendment on leases that don't have the
Estate Base Lease Expiration Date and Accounting End Date. (Tri-90963-1J47057)
Locations On the Work Task form, under the Resources tab, while adding the location

type resource record, the two fields, Name and Hierarchy Path, now populate
correctly from the selected Location record. (Tri-90372-1J30586)

Locations Building System Items records will get retired and removed from the Building
System Items section in the Location records when the corresponding Location
record is Retired.

Patch will retire all the existing Building System Items records that are not in
the retired state but associated with the retired building records.
(Tri-90412-1J45014).

Move Requests If you encounter any issue while submitting the move request, a user message
is displayed in the Attention section of the Move Request form. On revising any
request, such as service request, move request, inspection request, and so on,
if there is no request class associated with the building for which the request is
raised, the system automatically associates all the request classes based on
the request type.
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For example: If a move request is raised, then on revising it, if there is no
request class associated with the building for which the request is raised, the
system will automatically associate all the request classes (small move, group
move, individual move). (Tri-90335-1J25751).

Move Requests On completion of the last work task of a facility project for a move request,
the Facility Project will be completed as all the work tasks and related MLIs
and requests are completed. The attention message will no longer be
displayed. (Tri-90431-1J44495)

Move Requests The performance of the Group Move Perspective application in handling the

Performance large data sets for the item details page has significantly improved. The user
experience is now more responsive. The following change is worth mentioning:
Now a loading indicator is displayed next to the total line item count while
adding or removing line items. (Tri-89064-1J26083)

Move Requests The performance of the Group Move Perspective application in handling large

Performance data sets for the Search page has significantly improved. The user experience
is now more responsive than before. The following are some of changes worth
mentioning:

¢ A loading indicator is now displayed next to the total line item count
while adding or removing line items.

e For search page and item details page, sorting is now applied to the
asset, equipment, and room line items.

(Tri-89063-1J26084)

Move Requests The performance of the Group Move Perspective application in handling large
Performance data sets for the Search page has significantly improved. The user experience
Perceptive Group Move is now more responsive than before. The following are some of changes worth
App mentioning:

¢ A loading indicator is now displayed next to the total line item count
while adding or removing line items.

e For search page and item details page, sorting is now applied to the
asset, equipment, and room line items.

(Tri-89063-1J26084)

Microsoft Graph API While changing EWS API to Graph API, certain additional attributes must be
passed for the Graph API that were not required with EWS. These changes add
mappings for those additional requirements. (Tri-85164)

Object Migration The My Profile record of an employee will now be retired when the Employee
is retired. The user will no longer be able to log in when the record is in the
retired state. (Tri-90339-1J36995)

Organizations The system will identify duplicate "Contact Role" associated with any record
based on the Name and ID of the selected Contact and the Name of the
selected Role. If the preceding parameters match with the newly created
parameters, the system will display a warning message and will not allow you
to save the Contact Role. (Tri-90436-1J30384)

Other Floor Common type spaces will get prorated out if the floor is a 100% common
floor. In such cases, the floor common area will be added to the building
common area and get prorated. (Tri-90362-1J28585)
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People Active People Records will be displayed in the Home > Tasks > Manage
Resources > “My Team's Labor Details” and “My Team's Licenses and
Certifications” portal sections.

Also, the system now correctly displays Licenses and Certifications associated
to specific people records. (Tri-90432-1J25969)

People Now the system will display a user message for password change as per the
selected 'Optional Rule Requirements’ in Tools > System Setup >System >
Password Setup. (Tri-90370-1J27359)

Primary Location and If you change the name on the location record and click Save, the system will

Asset Allocation update the name on all the associated records. For example, primary work
location field of the Work Task records and primary location field of the Asset
records. (Tri-90434-1J30897)

Projects For the Facility Project type, the "Budget” and "Actuals” columns in the Project
section of the Program record are computed and the values are displayed.
These field values are computed from the Accounting section of the Budget tab
in the Facility Project. (Tri-90427-1J41960)

Report Scheduler In a report scheduler record, while setting up recurrence pattern type for the
scheduler, all the recurrences are working as designed. The show and hide
feature for Daily, Weekly, Monthly, and Yearly options is now working correctly
based on the selected recurrence pattern. (Tri-90336-1J43993)

Requests On a Service Request record raised for a specific building, you are allowed to
select any floor that is associated with the selected building. You can try
mapping different floors multiple times without clearing the existing floor from
the field. (Tri-90430-1J39947)

Requests Under General tab > Duplicate Search, the new "Associate Additional Asset &
Location?" check box is added to the Request Class form. If this check box is
selected, all the additional locations/assets can be associated with the work
tasks. This scenario is applicable only when the assignment rule in the Service
Plan is "Create single work task for all asset/location” and the Duplicate Search
option in the request class is set to "Auto-Assign to Duplicate”.
(Tri-90424-1J32956)

Reserve The system with active Reservation Policy records will follow the policy
criteria that include time, people, and room while creating or updating the
reservation records. Any reservation that does not comply with the Reservation
Policy criteria is declined. (Tri-90417-1J33880).

Reserve The system will display the Reservation Instance records in tabular format
whenever users try to drill down through the data point of the metric report
"triReservationResourceDayFact - Metric - Room Utilization Metric". The issue
occurs when users use "Calendar Day" as the Show by Filter. A new query
report is placed at the data point that will now render all the Reservation
Instance records. (Tri-90409-1J33202)

Reserve Purchase orders are generated for all the food orders. (Tri-88635-1J35117)
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Reserve A patch helper workflow has been created to set the default value for "Retry
Attempts” field under Reservation Settings tab of the Application Settings
record. (Tri-90639)

Reserve The Concierge form now calculates the End Date correctly after the form is
reset. (Tri-88686-1J24406)

Reserve The system will now map the Reservation ID and the correct End Time to the
notification when a resource gets declined. (Tri-88679)

Reserve The system will not block the Room/Space added to the Resource Downtime
Record if the Resource Downtime Record is in the Draft state. In such a
scenario, the Space records associated with the Resource Downtime record will
be available for reservations. (Tri-88688-1J34746)

Reserve Users will not be able to Accept or Reject the cancelled room via old Microsoft
Outlook email notifications. Also, now the Resource Owner will receive an
email notification whenever the Room Resource (Requestable) that is pending
for approval has been cancelled stating to Ignore the previous approval email
(Tri-88632-1J31157).

Reserve The system will now be able to cancel and update reservation occurrences by
importing the .ics file into Microsoft Outlook for the reservation record that is
created, updated, or cancelled by using the foundation TRIRIGA Application or
the Reserve Perceptive App. (Tri-88678-1J29842)

Reserve For a Recurrence meeting, reservations were set up initially with attendees
without adding a room. The system is now able to handle the updates done to
the individual occurrences while making reservation modifications. Therefore,
for such recurrence reservations, users can now update the room details later
for individual meeting occurrences. (Tri-88676-1J35305)

Reserve On modifying an existing 'Recurring’ type reservation where the status of some
of the reservation instances is completed, the system will successfully create
and update the future reservation instances; and the updated reservations will
also be considered in the Downtime Search. (Tri-90419-1J37165)

Reserve The system does not send auto-cancellation email notifications for the room
resources that are already declined. (Tri-88682)

Reserve The system will populate the reason in the Rejection Notification whenever
the Reservation Resource Record is Rejected by Resource Owner.
(Tri-88689-1J30927)

Reserve On updating the Resource Downtime record, the respective start and end dates
are now reflected in the associated offline resources/space records.
(Tri-88687-1J35272)

Reserve The End Date field in the Reservation Manager record is now updated correctly
after performing Early End or Check-Out. (Tri-88680-1J24451)

Reserve In the Reservation Auto Cancellation process, the system will trigger a
confirmation notification and trigger the required auto-cancel email to the end
user. (Tri-88685-1J35173)

© Copyright IBM Corporation 2023. 16



Area of Change Description

Reserve For a new reservation record, if something goes wrong while Reserve
communicates with the Exchange server resulting into a failed reservation, the
application marks this particular reservation for a "Retry", that is, the system
will again try to recreate the reservation based on the "Exchange Retry
Duration” that is scheduled on the Application Settings record > Reservation
Settings tab. By the scheduled date and time, if the reservation and Exchange
get the correct settings that are required, the reservation will be created
successfully. In a failed attempt, the system will again push this reservation
for a "Retry". Earlier, such multiple retry events were triggered infinitely in the
system, making the system inefficient and slow without the organizer being
aware of the issue.

To address the issue, a number field, “Retry Attempts”, is added

to Application Settings record > Reservation Settings tab. In the field,
maximum limit of the Retry Attempts to be scheduled for a particular
reservation can be specified. By default, it is set to three (3) Retry Attempts.
If the total Retry Attempts for a specific reservation reaches the Retry
Attempts specified, the system will send a notification to the reservation
organizer with the information about what is wrong with the reservation and
also no retry attempts will be scheduled for this reservation.

(Tri-88633 -1J39748)

Reserve Perceptive App | Fixed an issue on iPhone when swiping right, the VoiceOver feature loops on
the details of the first reservation where there are multiple reservations in a
month. It now moves on and announces the next reservations.
(Tri-88490-1J36448)

Reserve Perceptive App  When you search for a building in the Room Reservation app, VoiceOver for i0OS
devices will now read the building name and the second line of the address
(including city, state, and country) all together. This also applies to the
building name and address on the new page (right before you click on search).
(Tri-88536-1J36543)

Reserve Perceptive App | On an iPhone with the VoiceOver feature enabled, after swiping right from the
"My Reservations” button, the focus will move to the next item and announce
the "dimmed” button (disabled navigate to the previous page of reservations
button) instead of the "New Reservation” button. (Tri-88491-1J36460)

Security The UserName column is now removed from specific pages of the application
Ul to avoid brute force attacks. (Tri-90422-1J32427)

Space Allocation On the Allocation tab of a space record, the related reports in the Chargeback
Allocations section now display the removed active records for Space Level
Allocation. (Tri-90435-1J29914)

Tasks While capturing a reading via the Procedure Step of a task, the Reading log will
be associated with the existing "PM Reading Location/Asset" record of the asset
that has the same job plan as in the task and the same Reading Class and
Reading Units as in the Procedure Step. (Tri-90368-1J27828)

Tasks After activation of a work task, Procedure Steps will be displayed under the
Active Task Procedure Steps section. (Tri- 90407)

© Copyright IBM Corporation 2023. 17



Area of Change Description

Tasks TRIRIGA allows you to capture two different readings, for example, water
temperature and oil temperature, by using the same unit of measure (UOM) via
a single work task.

A new query section, 'Procedure Steps for Reading’, is added to the General tab
for preventative maintenance (PM) schedules based on the readings. The
system filters PM schedules based on the selected Procedure Steps for Reading
records in case PM Schedules have the same Reading Classification and Reading
UOM.

The new field "Procedure Step" has been added to the PM Reading
Location/Asset Form > General Tab > Job Plan section. The system will filter
PM Reading Location/Asset based on the Procedure Step field in cases where
PM reading records have the same Reading Class and Reading Units.

In cases where there are no Procedure Steps for the Reading record, the PM
schedules are filtered based on Reading Classification and Reading UOM.
Similarly, the PM Reading Location/Asset record is filtered based on the
Reading Class and Reading Units.

For example, there are two reading-based PM schedules, PS1 and PS2, in a
single job plan, JP1, where both the PM Schedules have Reading Classification
set to Temperature and Reading UOM set to degrees-Fahrenheit. Under the
Procedure Steps for Reading query section, PS1 has Oil Temperature selected
and PS2 has Water Temperature selected.

Scenario 1: If you want to capture the water temperature reading manually for
any asset with the help of JP1, then you must select Water Temperature as the
Procedure Step on the PM Reading Location/Asset record. After the reading log
record is associated with the PM Reading, PM schedule PS2 will be chosen by
the system for further task creation, if applicable.

Scenario 2: If you capture readings for any asset via the Task Procedure Step
record, for example, a task procedure step named Water Temperature, then
the reading log created will be associated with that PM Reading Location/Asset
record that has job plan JP1, reading class of Temperature, reading unit of
degrees-Fahrenheit, and procedure step of Water Temperature. If the system
does not find any reading with the procedure step Water Temperature, then
the system will associate a reading log with that PM Reading Location/Asset
record where the reading class is Temperature, reading unit is degrees
Fahrenheit, and Procedure Step is blank/null. (Tri-90406-1J30787)

Workplace Services If the End Early option is executed for a meeting in Microsoft Exchange, the
Perceptive App reservation record will be updated and will display the shortened time
correctly. (Tri-88681-1J33876)

Workplace Services On i0S, when VoiceOver is turned ON, opening the search location page while

Perceptive App creating a new reservation announces the fields on the previous page. It briefly
goes to an invisible element but snaps back to the upper-left corner to the
back button. (Tri-88492-1J36466)

Work Task On completion of a Work Task, the corresponding Service Request is also
marked as completed, irrespective of whether the task is associated with the
Facilities project. (Tri-90410-1J39610)

Work Task Perceptive

App While viewing large number of Work Task records in the Unassigned tab, the

data is now paginated to display 50 records per page. Scroller can fetch further
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data while switching between different views.
(Tri-87560-1J35111)

Work Task Perceptive All the tiers of the location path will be displayed in the work task.
App (Tri-87588-1J40203)

Work Task Perceptive Work Tasks can now be searched based on the status.
App (Tri-87677-1J35768)

Work Task Perceptive The In progress, Completed, and Draft tabs are now paginated. After adding
App pagination to all the tabs, the page is no longer unresponsive.
(Tri-87679-1J36486)

Workflow Closing and reopening any type of asset record under Portfolio > Assets will not
show a warning message in a workflow instance if the value of the Workflow
Name field in the Dynamic Workflow (triShowHideDynWorkflowTX) is blank.
(Tri-90414-1J31892)

Workflow While capturing reading via the Procedure Step of a task, the Reading Log will
be associated to the existing ‘PM Reading Location/Asset’ record of the asset,
where Reading Class and Reading Units are same as in the Procedure Step.
(Tri- 90416 -1J27828)
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Related Documentation

The IBM TRIRIGA documentation is at https://www.ibm.com/docs/en/tririga and the IBM TRIRIGA
Application Platform documentation is at https://www.ibm.com/docs/en/tap. The documentation is
available online in topics or as downloadable PDF files.

Additional documentation, previously available in the IBM TRIRIGA wiki, is available on IBM TRIRIGA
Application Platform 3.8. For more information, see the IBM TRIRIGA Release Information page on IBM
Support.

Support

IBM Software Support provides assistance with product defects, answering FAQs, and performing rediscovery.
View the IBM Software Support site at www.ibm.com/support.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult
your local IBM representative for information on the products and services currently available in your area.
Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product, program, or service that
does not infringe any IBM intellectual property right may be used instead. However, it is the user's
responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents. You can send license
inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions
are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow
disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in new editions of the publication. IBM may
make improvements and/or changes in the product(s) and/or the program(s) described in this publication at
any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any
manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the
materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this one)
and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
274A/101

11400 Burnet Road
Austin, TX 78758
U.S.A.
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Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any
equivalent agreement between us.

Information concerning non-1BM products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those products and cannot confirm
the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on
the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice,
and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals, companies, brands, and products.
All of these names are fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

Privacy Policy Considerations

IBM Software products, including software as service solutions, (“Software Offerings”) may use cookies or
other technologies to collect product usage information, to help improve the end user experience, to tailor
interactions with the end user or for other purposes. In many cases no personally identifiable information is
collected by the Software Offerings. Some of our Software Offerings can help enable you to collect
personally identifiable information. If this Software Offering uses cookies to collect personally identifiable
information, specific information about this offering’s use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable
information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek your
own legal advice about any laws applicable to such data collection, including any requirements for notice
and consent.

For more information about the use of various technologies, including cookies, for these purposes, see IBM’s
Privacy Policy at www.ibm.com/privacy and IBM's Online Privacy Statement at
http://www.ibm.com/privacy/details/us/en in the section entitled “Cookies, Web Beacons and Other
Technologies.”

Trademarks

IBM, the IBM logo, ibm.com, and TRIRIGA are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of
Adobe Systems Incorporated in the United States, and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its
affiliates.

Other product and service names might be trademarks of IBM or other companies. A current list of IBM
trademarks is available on the Web at “Copyright and trademark information” at
www.ibm.com/legal/copytrade.shtml.
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